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1Managing Email 
Messages with Outlook

Objectives
After completing this module, you will be able to:

•	Add a Microsoft account to Outlook

•	Set language preferences and Sensitivity 
levels

•	Apply a theme

•	Compose, address, and send an email 
message

•	Open, read, print, and close an email 
message

•	Preview and save a file attachment

•	Display the People Pane

•	Reply to an email message

•	Check spelling as you type an email 
message

•	Attach a file to an outgoing email 
message

•	Forward an email message

•	Copy another person when sending an 
email message

•	Create and move messages into a folder

•	Delete an email message

•	View the mailbox size

What Is Outlook?
The Office application, Microsoft Outlook, helps you organize and manage your 
communications, contacts, schedules, and tasks. Email (short for electronic mail) is the 
transmission of messages and files between computers or smart devices over a network. 
An email client, such as Microsoft Outlook, is an app that allows you to compose, send, 
receive, store, and delete email messages. Outlook can access mail servers in a local 
network, such as your school’s network, or on a remote network, such as the Internet. 
Finally, you can use Outlook to streamline your messages so that you easily can find and 
respond to them later.

To use Outlook, you must have an email account. An email account is an electronic 
mailbox you receive from an email service provider, which is an organization that 
provides servers for routing and storing email messages. Your employer or school could 
set up an email account for you, or you can do so yourself through your Internet service 
provider (ISP) or using a web application such as a Microsoft account, Google Gmail, 
Yahoo! Mail, or iCloud Mail. Outlook does not create or issue email accounts; it merely 
provides you with access to them. When you have an email account, you also have an 
email address, which identifies your email account on a network so you can send and 
receive email messages.
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Project: Composing and Sending Email 
Messages
The project in this module follows the general guidelines for using Outlook to 
compose, open, and reply to email messages, as shown in Figure 1–1. To communicate 
with individuals and groups, you typically send or receive some kind of message. 
Texting, tweeting, and email are examples of ways to communicate a message. Email 
is a convenient way to send information to multiple people at once.
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(b) Display the Inbox

Figure 1–1

(c) Reply and Attach a File to a Message

(a) Compose a Message

Jackson Torborg, an intern at the Disrupt Rockland Code Squad, uses Outlook 
to connect with the youth in the Rockland area to educate them about career pathways 
in coding. This module uses Microsoft Outlook to compose, send, read, reply to, and 
forward email messages regarding an upcoming field trip to a major tech company. 
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Jackson has been asked by Dr. Chloe Pauley, the director of Disrupt Rockland, to 
coordinate the tech giant field trip. Using Outlook, Jackson reads email messages 
from his director and local youth regarding the field trip and coding workshop 
opportunities. He replies to email messages and includes a document containing a flyer 
about the field trip. To organize messages, he also creates folders and then stores the 
messages in those folders.

In this module, you will learn how to perform basic email messaging tasks. You 
will perform the following general activities as you progress through this module:

1.	 Configure the account options.
2.	 Compose and send an email message.
3.	 View and print an email message.
4.	 Reply to an email message.
5.	 Attach a file to an email message.
6.	 Organize email messages in folders.

To Start Outlook

If you are using a computer to step through the project in this module and you 
want your screens to match the figures in this book, you should change your screen’s 
resolution to 1366 × 768. 

The following steps, which assume Windows 10 is running, use the Start menu 
to start Outlook based on a typical installation. You may need to ask your instructor 
how to start Outlook on your computer. 

1	 Click the Start button on the Windows 10 taskbar to display the Start menu.

2	 Scroll to and then click Outlook in the apps list to run Outlook.

3	 If the Outlook window is not maximized, click the Maximize button on its title bar to 
maximize the window.

Setting Up Outlook
Many computer users have an email account from an online email service provider 
such as Outlook.com or Gmail.com and another email account at work or school. You 
can add many types of email accounts to Outlook, including an Office 365 account 
as shown in Figure 1–2, and Gmail, Yahoo, iCloud, and Exchange accounts. Instead 
of using a web app for your online email account and another app for your school 
account, you can use the Outlook client (installed version of Outlook) to access all of 
your email messages in a single location. Outlook provides cloud storage for storing 
information like emails, calendars, contacts, and tasks. When you access your email in 
Outlook, you can take advantage of a full set of features that include social networking, 
translation services, and having Outlook read your email aloud to you. You can read 
your downloaded messages offline and set options to organize your messages in a way 
that is logical and convenient for you.
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What should you do if you do not have an email address?
Use a browser such as Microsoft Edge to go to the Outlook.com or Gmail.com website. Look for a Create an Account link or 
button, click it, and then follow the instructions to create an account, which includes creating an email address.

Parts of an Email Address
An email address is divided into two parts. The first part contains a user name, 

which is a combination of characters that identifies a specific user. The last part is a 
domain name, which is the name associated with a specific Internet address and is 
assigned by your email service provider. A user name must be different from other user 
names in the same domain. For example, the outlook.com domain can have only one 
user named Jackson.Torborg. An email address contains an @ (pronounced at) symbol 
to separate the user name from the domain name. Figure 1–3 shows an email address 
for Jackson Torborg, which would be read as Jackson dot Torborg at outlook dot com. 

Enter an 
email address

Figure 1–2

Figure 1–3

jackson.torborg@outlook.com

user name domain name

To Add an Email Account

You can add one or more of your email accounts to Outlook. For most accounts, 
Outlook automatically detects and configures the account after you type your name, 
email address, and password. Add an email account to Outlook when you are working 
on your personal or home computer only. You do not want your personal information 
or email messages on a public computer. Although most people add an email account 
the first time Outlook runs, you can add email accounts at any time. This module 
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assumes you already set up an email account in Outlook. If you choose to add an email 
account to Outlook, you would use the following steps.

1.	 Click the File tab, and then click Add Account.
2.	 Click the Email Address text box, and then type your full email address to 

associate your email address with the account.
3.	 Click the Connect button and then select the type of account, such as Outlook.

com, in the Advanced setup window.
4.	 Click the Password text box, and then type your password to verify the password 

to your email account.
5.	 Click the Retype Password text box, and then type your password again to 

confirm your password.
6.	 Click the Finish button to add your email account.

To Change from the Simplified Ribbon to the Classic Ribbon

When you first open Microsoft Outlook, the Simplified ribbon (single-row) 
is displayed to dedicate more screen space to viewing your email than the traditional 
Classic ribbon as shown in Figure 1–4. The Simplified ribbon includes the most 
frequently used features. You can expand it to access the full set of commands on the 
Classic three-line ribbon. This module uses the full Classic ribbon. If you need to 
change the Simplified ribbon to Classic ribbon, you would use the following steps.

1.	 Click the Switch Ribbons arrow on the right side of the Simplified ribbon to 
display the Classic ribbon.

BTW
The Ribbon and 
Screen Resolution 
Outlook may change how the 
groups and buttons within the 
groups appear on the ribbon, 
depending on the computer 
or mobile device’s screen 
resolution. Thus, your ribbon 
may look different from the 
ones in this book if you are 
using a screen resolution 
other than 1366 × 768.

You may see a 
different ribbon using 
Office 2019 rather 
than Office 365.

(a) Simplified Ribbon

Switch Ribbons 
arrow

(b) Classic Ribbon

Figure 1–4

Switch Ribbons 
arrow
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How do you remove an email account in Outlook? 

•	Click the File tab on the ribbon. 

•	Click the Account Settings button, and then click Account Settings to display the Account Settings dialog box. 

•	Click the account you want to remove, and then click Remove.

•	In the Account Settings dialog box, click the Yes button.
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The Navigation Pane and Navigation Bar
The Navigation pane appears on the left side of the Outlook window and is how 

you switch between the different areas of Outlook, such as Mail, Calendar, Contacts, 
Tasks, and Notes. The lower-left corner of the screen provides a Navigation bar that 
displays small icons representing Mail, Calendar, Contacts, and Tasks as shown in 
Figure 1–5.

Figure 1–5

Navigation 
pane

Navigation 
bar

Mail

Calendar People

Tasks

If the left pane in your Outlook window is not expanded as it is in Figure 1–5, 
click the Expand the Folder Pane button, which is a small arrow button to the left of 
today’s date in the Outlook window. 

To Open an Outlook Data File

Microsoft Outlook uses a special file format called a personal storage table (.pst file) to save your email 
files, calendar entries, and contacts. The email messages with which you work in this module are stored in a 
personal storage table file named SC_OUT_1-1.pst, which is located with the Data Files. To complete this 
assignment, you will be required to use the Data Files. Please contact your instructor for information about 
accessing the Data Files. In this example, SC_OUT_1-1.pst contains a Jackson mailbox and is located in the 
Module folder in the Outlook1 folder in the Data Files folder. The following steps open the SC_OUT_1-1 
.pst file in Outlook, display the Inbox for the Jackson mailbox, and then make your Jackson mailbox match the 
figures in this module. Why? Importing a .pst file allows you to move your email and other Outlook information to 
another computer.
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1
•	Click File on the 

ribbon to open 
Backstage view.

•	Click the Open 
& Export tab in 
Backstage view to 
display the Open 
gallery (Figure 1–6).

Figure 1–6

Backstage view

Open gallery

Open & 
Export tab

Open Outlook  
Data File

2
•	Click Open Outlook Data File to 

display the Open Outlook Data 
File dialog box.

•	Navigate to the mailbox location 
(in this case, the Module folder in 
the Outlook1 folder in the Data 
Files folder) (Figure 1–7).

Figure 1–7

Module folder

SC_OUT_1-1.pst file

Open button

3
•	Click SC_OUT_1-1.pst to select the file, and then click OK (Open Outlook Data File dialog box) to open the mailbox 

in your Outlook window.

•	If necessary, click the white triangle next to the Outlook Data File mailbox in the Navigation pane to expand the 
folders.

Note: To help you locate screen 
elements that are referenced in the 
step instructions, such as buttons and 
commands, this book uses red boxes to 
point to these screen elements.
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•	Click the Inbox folder below the Outlook Data File heading in the Navigation pane to view Jackson’s Inbox 
(Figure 1–8).

What is the Inbox? 
The Inbox is the Outlook folder that contains incoming email messages. 

The contact photo shown in Figure 1–8 does not appear in my Outlook window. What should I do? 
Outlook needs to synchronize the contact photos with the email addresses in the Jackson mailbox. Click the Close 
button to close Outlook, restart it, and then expand the Outlook Data File in the Navigation pane to have the 
photos appear. You also might need to import the Data File rather than opening it. In Step 2 on this page, click 
Import/Export instead of Open Outlook Data File. The pictures are also part of the student files. 

Q
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A

Figure 1–8
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How do I change the language preferences, for example from Spanish to English?

•	Click File on the ribbon to open Backstage view.

•	Click the Options tab in Backstage view to display the Outlook Options dialog box.

•	In the left pane, click Language (Outlook Options dialog box) to display the Language options.

•	Click the ‘[Add additional editing languages]’ arrow to display a list of editing languages that can be added to Outlook.

•	If necessary, scroll the list and then click English (United States) to set the default editing language. Otherwise, click the ‘[Add 
additional editing languages]’ arrow again to close the list.

To Set the Sensitivity Level for All New Messages

The Sensitivity level of a message advises the recipient on how to treat the contents of the message. 
Sensitivity levels are Normal, Personal, Private, and Confidential. Changing the Sensitivity setting in the 
Outlook Options dialog box changes the default Sensitivity level of all messages created afterward. Why? For 
example, if you set the Sensitivity level of a message to Confidential, the information should not be disclosed to anyone except 
the recipient. The following steps set the default Sensitivity level.

m
ic

ha
el

ju
ng

/S
hu

tt
er

st
oc

k.
co

m

Copyright 2020 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part. Due to electronic rights, some third party content may be suppressed from the eBook and/or eChapter(s).
Editorial review has deemed that any suppressed content does not materially affect the overall learning experience. Cengage Learning reserves the right to remove additional content at any time if subsequent rights restrictions require it.

Copyright 2020 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part.  WCN 02-200-203



Managing Email Messages with Outlook   Outlook Module 1   OUT 1-9

O
u

tl
o

o
k 

M
o

d
u

le
 1

1
•	Click File on the ribbon to open 

Backstage view (Figure 1–9).

Figure 1–9

Options tab

Backstage 
view

2
•	Click the Options tab in Backstage view to display the Outlook Options dialog box.

•	In the left pane, click Mail (Outlook Options dialog box) to display the Mail options.

•	Drag the scroll bar to display the Send messages area (Figure 1–10).

Figure 1–10
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3
•	Click the ‘Default Sensitivity level’ 

arrow to display a list of Sensitivity 
levels (Figure 1–11).

4
•	If necessary, click Normal to set 

the default Sensitivity level of all 
new messages.

•	Click OK to close the Outlook 
Options dialog box.

Figure 1–11

Normal sensitivity 
level set by default

OK button

Composing and Sending Email Messages
Composing an email message is the most frequent personal and business task you 
perform in Microsoft Outlook. Composing an email message consists of four basic 
steps: open a new message window, enter message header information, enter the 
message text, and add a signature. When composing an email message, it is best to 
keep your message text concise and to the point. If you must write a longer, detailed 
message, break up your message into bullet points or into separate emails each with a 
clear summary of action.

An email message is organized into two areas: the message header and the 
message area. The information in the message header routes the message to its 
recipients and identifies the subject of the message. The message header identifies 
the primary recipient(s) in the To box. If you have multiple recipients in the To box, 
you can separate each email address with a semicolon. Recipients in the Cc (courtesy 
copy or carbon copy) and Bcc (blind courtesy copy) boxes, if displayed, also receive the 
message; however, the names of the recipients in the Bcc box are not visible to other 
recipients. The subject line states the purpose of the message.

The message area, where you type an email message, consists of a greeting line 
or salutation, the message text, an optional closing, and one or more signature lines as 
shown in Table 1–1.

Copyright 2020 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part. Due to electronic rights, some third party content may be suppressed from the eBook and/or eChapter(s).
Editorial review has deemed that any suppressed content does not materially affect the overall learning experience. Cengage Learning reserves the right to remove additional content at any time if subsequent rights restrictions require it.

Copyright 2020 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part.  WCN 02-200-203



Managing Email Messages with Outlook   Outlook Module 1   OUT 1-11

O
u

tl
o

o
k 

M
o

d
u

le
 1

Table 1–1  Message Area Parts

Part Description

Greeting line or salutation Sets the tone of the message and can be formal or informal, depending on the 
nature of the message. You can use a colon (:) or comma (,) at the end of the 
greeting line.

Message text Informs the recipient or requests information.

Closing Informs the recipient or requests information. A closing line is an end to the 
message using courtesy words such as Thank you or Regards. Because the 
closing is most appropriate for formal email messages, it is optional.

Signature line(s) Identifies the sender and may contain additional information, such as a job 
title, business name, and phone number(s). In a signature, the name usually is 
provided on one line followed by other information listed on separate lines.

To Compose an Email Message

An email message from Jackson Torborg, the intern at Disrupt Rockland Code Squad, requests 
information about the tech field trip from the director named Chloe Pauley. The following steps compose 
a new email message. Why? Composing email messages is a direct and efficient method to connect with personal and 
professional contacts.

1
•	Click the New Email 

button (Home tab | 
New group) 
to open the 
Untitled –  
Message (HTML)  
window 
(Figure 1–12).

Figure 1–12

insertion point 
in To text box

New 
Email 
button

Untitled – Message (HTML) window

2
•	Type   chloe 
.pauley@outlook 
.com   (with no 
spaces) in the To 
text box to enter the 
email address of the 
recipient. 

•	Click the Subject text 
box, and then type   
Tech Giant Field 
Trip   to enter the 
subject line.

•	Press tab to move 
the insertion point 
into the message 
area (Figure 1–13).

Figure 1–13

recipient email address

email message subject line

message area
insertion point
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3
•	Type   Dear Ms. 
Pauley,   as the 
greeting line.

•	Press enter to move 
the insertion point 
to the beginning of 
the next line.

•	Press enter again 
to insert a blank 
line between the 
greeting line and 
the message text 
(Figure 1–14).

My message text 
includes paragraph 
and space marks. 
How can I hide 
them? 
Click Format Text on the ribbon, and then click the Show/Hide button (Format Text tab | Paragraph group) to hide 
the paragraph and space marks.

4
•	Type   Please send 
me the details 
about the Tech 
Giant Field Trip 
event so I can 
begin inviting 
our local youth.   
to enter the message 
text.

•	Press enter two times 
to insert a blank line 
below the message 
text (Figure 1–15).

Q
&

A

Figure 1–14

insertion point

greeting line

blank line inserted

Figure 1–15

insertion point

blank line inserted
message 
text

5
•	Type   Thanks,   to enter the closing for the message.

•	Press enter to move the insertion point to the next line.

•	Type   Jackson Torborg   as the first line of the signature.

•	Press enter to move the insertion point to the next line.

•	Type   Disrupt Rockland Code Squad   as the second line of the signature.
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•	Press enter to move 
the insertion point 
to the next line.

•	Type   Intern   as 
the third line of 
the signature 
(Figure 1–16).

Figure 1–16

closing

signature lines

Other Ways

1. Click Inbox folder, press ctrl+n

To Apply a Theme

An Outlook theme can give an email message instant style and personality. Each theme provides a unique 
set of colors, fonts, and effects. The following steps apply a theme to the message. Why? Themes give your 
organization’s communications a modern, professional look using subtle styles.

1
•	Click Options on the ribbon to display the Options tab.

•	Click the Themes button (Options tab | Themes group) to display the Themes gallery (Figure 1–17).

Figure 1–17

Slice 
theme

Themes 
gallery

Options tab

Themes 
button
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2
•	Click Slice in the 

Themes gallery to 
change the theme 
of the message 
(Figure 1–18).

Figure 1–18

Send 
button

Slice theme is applied 
to message text

To Send an Email Message

The following step sends the completed email message to the recipient. Why? After you complete a message, 
you send it to the recipient, who typically receives the message in seconds.

1
•	Click the Send button in the message header to send the email message and close the message window.

What happened to the email message?
Outlook automatically sends email messages to their recipient(s) when you click Send in a new message window if 
you have your own email account set up. 

Why did I get an error message that stated that ‘No valid email accounts are configured. Add an account to send 
email’?
If you do not have an email account set up in Outlook, you cannot connect to the Internet to send the email. 
Click Cancel to close the error message. 

Q
&

A

Other Ways

1. Press alt+s

How Email Messages Travel from Sender to Receiver
When you send someone an email message, it travels across the Internet to 

the computer at your email service provider that handles outgoing email messages. 
This computer, called the outgoing email server, examines the email address on 
your message, selects the best route for sending the message across the Internet, 
and then sends the email message. Many outgoing email servers use SMTP 
(Simple Mail Transfer Protocol), which is a communications protocol, or set of 
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rules for communicating with other computers. An email program such as Outlook 
contacts the outgoing email server and then transfers the email message(s) in its 
Outbox to that server. If the email program cannot contact the outgoing email 
server, the email message(s) remains in the Outbox until the program can connect 
to the server.

As an email message travels across the Internet, routers direct the email 
message to a computer at your recipient’s email service provider that handles 
incoming email messages. A router is a device that forwards data on a network. 
The computer handling incoming email messages, called the incoming email 
server, stores the email message(s) until your recipient uses an email program such 
as Outlook to retrieve the email message(s). Some email servers use POP3, the 
latest version of Post Office Protocol (POP), a communications protocol for 
incoming email. Figure 1–19 shows how an email message may travel from a sender 
to a receiver.

Figure 1–19
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Working with Incoming Messages
When you receive email messages, Outlook directs them to your Inbox and displays 
them in the message pane, which lists the contents of the selected folder (Figure 1–20).  
The list of messages displayed in the message pane is called the message list. An 
unread (unopened) email message in the message list includes a blue vertical bar in 
front of the message and displays the subject text and time of arrival in a blue bold 
font. The blue number next to the Inbox folder shows how many unread messages 
are stored in the Inbox. The email messages on your computer may be different from 
those in Figure 1–20.

BTW
Know the Sender
If you receive an email 
message from someone you 
do not know, you should 
not open it because it might 
trigger a virus. Unsolicited 
email messages, known as 
spam or junk email, are 
email messages sent from 
an unknown sender to many 
email accounts, usually 
advertising a product or 
service such as low-interest 
loans or free credit reports. 
Do not click a hyperlink in 
an email message from an 
unknown sender. A hyperlink 
is a word, phrase, symbol, or 
picture in an email message 
or on a webpage that, when 
clicked, directs you to another 
document or website.
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You can read incoming messages in three ways: in an open window, in the 
Reading Pane, or as a hard copy. A hard copy (printout) is information presented on a 
physical medium such as paper.

Figure 1–20
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To View an Email Message in the Reading Pane

The Reading Pane appears on the right side of the Outlook window by default and displays the contents of a 
message without requiring you to open the message. An advantage of viewing messages in the Reading Pane is that if a 
message includes content that could be harmful to your computer, such as a malicious script or an attachment containing 
a virus, the Reading Pane does not activate the harmful content. An attachment is a file such as a document or picture 
you send along with an email message. The attached document can be a file saved to your local computer or from 
OneDrive, as long as you have Microsoft’s cloud service account connected. The events director Chloe Pauley has sent a 
response to Jackson concerning the next Code Squad workshop. The following step uses the Reading Pane to display an 
email message from a sender. Why? You use the Reading Pane to preview message in your Inbox without opening them.

1
•	Click the message 

header from Chloe 
Pauley in the Inbox 
message list to 
select the email 
message and display 
its contents in 
the Reading Pane 
(Figure 1–21).

What happens 
to the message 
header when I select 
another message?
Outlook 
automatically marks 
messages as read 
after you preview 
the message in the 
Reading Pane and 
select another message 
to view. A read message is displayed in the message list without a vertical blue line or bold text.
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Figure 1–21
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To Open an Email Message in a Window

The following step displays an email message from a sender in a window. Why? To fully evaluate an email 
message and use additional Outlook tools for working with messages, you display the email message in a window.

1
•	Double-click the 

Chloe Pauley 
message in the 
message list to 
display the selected 
email message in 
its own window 
(Figure 1–22).

Figure 1–22

identifying information

attachment

greeting line

message text

signature

Opening Attachments
Email messages that include attachments are identified by a paper clip icon in 

the message list. Users typically attach a file to an email message to provide additional 
information to the recipient. An attachment in a message can appear in a line below 
the subject line or in the message body. To help protect your computer, Outlook does 
not allow you to receive files as attachments if they are a certain file type, such as 
.exe (executable) or .js (JavaScript), because of their potential for introducing a virus 
into your computer. When Outlook blocks a suspicious attachment in a message, the 
blocked file appears in the InfoBar at the top of your message. An InfoBar is a banner 
displayed at the top of an email message that indicates whether an email message has 
been replied to or forwarded.

The Attachment Preview feature in Outlook allows you to preview an 
attachment you receive in an email message from either the Reading Pane in an 
unopened message or the message area of an opened message. Outlook has built-in 
previewers for several file types, such as other Office programs, pictures, text, and 
webpages. Outlook includes attachment previewers that work with other Microsoft 
Office programs so that users can preview an attachment without opening it. These 
attachment previewers are turned on by default. To preview an attached file created 
in an Office application, you must have Office installed on your computer. For 
example, to preview an Excel attachment in Outlook, you must have Excel installed. 
If an attachment cannot be previewed, you can double-click the attachment to open 
the file. If you suspect an attachment is not safe or decide it is not necessary, you can 
delete the attachment by right-clicking it in the message window, and then clicking 
Remove Attachment on the shortcut menu.
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To Preview and Save an Attachment

Why? When you receive a message with an attachment, you can preview the attached file without opening it if 
you are not sure of the contents. A common transmission method of viruses is by email attachments, so be sure 
that you trust the sender before opening an attached file. The following steps preview and save an attachment 
without opening the file. You should save the attachment on your hard disk, OneDrive, or a location that is 
most appropriate to your situation. These steps assume you already have created folders for storing your files, 
for example, a CIS 101 folder (for your class) that contains an Outlook1 folder with a Module folder (for your 
assignments). Thus, these steps save the attachment in the Module folder in your desired save location. 

1
•	Click the fieldtrip 

.docx file 
attachment in the 
message header 
of the opened 
email from Chloe 
Pauley to preview 
the attachment 
within Outlook 
(Figure 1–23).

2
•	Click the Save As 

button (Attachment 
Tools Attachments tab 
| Save to Computer 
group) to display the 
Save Attachment 
dialog box.  

•	Navigate to the 
desired save location 
(in this case, the 
Module folder in 
your Outlook1 folder 
or your class folder 
on your computer or 
OneDrive).

•	Change the file 
name to   SC_
OUT_1_Fieldtrip,   
and, if requested by 
your instructor, add 
your last name to 
the end of the file name (Figure 1–24).
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Figure 1–24
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3
•	Click the Save button (Save Attachment dialog box) to save the document in the selected folder in the selected 

location with the entered file name.

•	Click Close to close the attachment preview window and email message (Figure 1–25).

To Open an Attachment

If you know the sender and you know the attachment is safe, you can open the attached file. The following 
steps open an attachment. Why? By opening a Word attachment in Microsoft Word, you can edit the document with the 
full features of Word.

1
•	If necessary, click 

the message header 
from Chloe Pauley in 
the Inbox message 
list to select the 
email message and 
display its contents 
in the Reading Pane.

•	Double-click the 
attachment in 
the Reading Pane 
to open the file 
attachment in 
Microsoft Word 
in Protected View 
(Figure 1–26).

2
•	Click Close to close 

the Word file.

Figure 1–25
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To Print an Email Message

Occasionally, you may want to print the contents of an email message. Why? A hard copy of an email message 
can serve as reference material if your storage medium becomes corrupted and you need to view the message when your 
computer is not readily available. A printed copy of an email message also serves as a backup, which is an additional 
copy of a file or message that you store for safekeeping. You can print the contents of an email message from an 
open message window or directly from the Inbox window.

You would like to have a hard copy of Chloe Pauley’s email message for reference about the upcoming 
tech field trip. The following steps print an email message.

1
•	If necessary, click Home on the ribbon to display 

the Home tab.

•	In the message list, right-click the Chloe Pauley 
message header to display a shortcut menu that 
presents a list of possible actions (Figure 1–27).

2
•	Click the Quick Print command on the shortcut 

menu to send the email message to the 
currently selected printer.

Figure 1–27
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Using the Outlook People Pane
Outlook provides a means of viewing email history, attachments, and meetings 

associated with each sender in the Reading pane. The People Pane accesses 
information about each of your contacts. The People Pane can display the photos and 
contact information of the email sender and recipient at the bottom of the Reading 
Pane in one location.

To Change the View of the People Pane

By default, the People Pane is not displayed in the Reading Pane. By changing the People Pane to the 
Minimized setting, the contact information is displayed as a one-line bar below an open email message and does 
not take up a lot of room in the Reading Pane or open message window. To view more details, you can change 
the People Pane view to Normal. Why? When you are reading a message in Outlook, you can use the People Pane to 
view more information about the contacts associated with the message, such as the senders and receivers of the message. The 
following steps change the view of the People Pane.
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